
 

 

 

 

 
 

 

 

 

 

Vor der Verwendung des Produkts lesen Sie die Bedienungsanleitung sorgfältig 

durch und bewahren Sie sie auf. Laden Sie zusammenhängende Tools und 

Produktdokumente unter http://www.herospeed.net herunter . 

NVR-Netzwerk-
Videorekorder 

mit WiFi-Anschluss 

Gebrauchsanweisung 

DE 

http://www.herospeed.net/


Erklärung 

Vielen Dank für den Kauf unserer Produkte. Wenn Sie 
Fragen haben, zögern Sie bitte nicht, Kontakt mit uns 
aufzunehmen. 

Diese Anleitung bezieht sich auf VCR-Kits mit WiFi-
Konnektivität (drahtlose NVR Geräte und drahtlose Kameras). 

Das Handbuch wird je nach Produktaktualisierung aktuell 

gemacht, eine neue Version wird nicht ausdrücklich 

angekündigt. 
Wenn eine der Produktbeschreibungen in dieser Anleitung 
mit den tatsächlichen Produkten nicht übereinstimmt, lesen 
Sie bitte das Handbuch für die neuere/ältere Version des 
Produkts durch. 

Sicherheitshinweise 
1. Nach der Installation des Geräts sofort das Standardpasswort ändern, um das 

Gerät vor Diebstahl zu schützen. 

2. Das Gerät in direktem Sonnenlicht oder in der Nähe von Heizgeräten nicht 

aufstellen. 

3. Das Gerät in feuchten und staubigen Umgebungen oder in Umgebungen mit 

Rußverbrennung nicht aufstellen. 

4. Das Gerät an einem stabilen Standort installieren. Das Gerät nicht fallen lassen. 

5. Das Verschütten von Flüssigkeiten auf ein NVR Gerät vermeiden und 

sicherstellen, dass keine mit Flüssigkeit gefüllten Gegenstände auf das Gerät 

gestellt werden, um zu verhindern, dass Flüssigkeit ins Gerät fließt.  

6. Das Gerät an einem gut belüfteten Standort aufstellen. Darauf achten, dass die 

Lüftungsöffnungen des Geräts nicht blockiert werden. 

7. Das Gerät nur innerhalb seiner Nenneingangs-/Nennausgangsleistung 

verwenden. 

8. Das Gerät nicht auseinandersetzen, ohne den Lieferanten zu informieren. 

9. Das Gerät nur in einer Umgebung mit zulässigem Feuchtigkeits- und 

Temperaturbereich befördern, verwenden.  



Haftungsausschluss 

Beachten Sie bitte insbesondere die folgenden Ausnahmen und 

Einschränkungen: 

1. Wenn das Gerät aus einem der folgenden Gründe nicht mehr 

funktioniert, haftet unser Unternehmen nicht für Personen- oder 

Sachschäden, die Sie oder Dritte erleiden: A. Installation oder 

Verwendung des Geräts stimmt mit den hierin enthaltenen 

Anweisungen nicht über; B. Einhaltung behördlicher Vorschriften; C. 

Höhere Gewalt; D. Ihre eigenen Gründe oder die von Dritten, 

einschließlich, jedoch nicht nur, der Verwendung von Produkten, 

Software, Komponenten usw. von Dritten. 

2. Unser Unternehmen haftet für das Gerät nicht, wenn es für spezielle 

Zwecke oder auf eine andere Art und Weise, ausdrücklich oder 

stillschweigend, als hier angegeben verwendet wird. Dieses Gerät darf 

im Zusammenhang mit medizinischen/sicherheitstechnischen Geräten 

oder anderen Produkten, die Gefahr für das Leben oder für Personen 

darstellen, oder im Zusammenhang mit Massenvernichtungswaffen, 

biologischen und chemischen Waffen nicht verwendet werden. 

Jegliche Verluste oder Haftungen, die sich aus der oben genannten 

Nutzung ergeben, erfolgen auf Ihr eigenes Risiko. 

3. Dieses Gerät kann bei ordnungsgemäßer Installation und Verwendung 

bestimmte illegale Störungen erkennen, ist jedoch nicht in der Lage, 

Unfälle und dadurch verursachte Personen- oder Sachschäden zu 

verhindern. Sie sollten in Ihrem täglichen Leben vorsichtigsein. 

4. Wir haften nicht für Folge-, Neben-, Sonder- oder repressive Schäden, 

Ansuchen, Verlust von Eigentum oder Verlust von Daten und 

Dokumenten. Soweit gesetzlich zulässig, übersteigt unsere Haftung 

für Schäden den Betrag nicht, der bei dem Kauf dieses Produkts 

bezahlt wurde. 
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 Antenne 

1. Beschreibung des Aussehens des Geräts 

LAN, Audio-Ausgang, VGA, HD, USB 2.0, Eingangsanschluss, Antenne. 
 

Audiousgang Eingangsport 
 

2. Wi-Fi NVR Schnellinstallationsanleitung 

Dieses Wi-Fi NVR-Kit benötigt weder ein Kabel noch eine spezielle 

Einstellung. Eine einfache Installation, das sog. Plug-and-Play-Prinzip, die 

kabellose Kommunikation verwendet einen automatischen 

Passwortgenerierungsmechanismus, um sicherzustellen, dass das gefolgte 

Video nicht missbraucht wird. 

 

 Installation einer Festplatte 

Vergewissern Sie sich vor der Installation, dass die Stromzufuhr unterbrochen ist. 

Installationswerkzeug: Kreuzschlitzschraubendreher. 

BEMERKUNG: 

Verwenden Sie die von Ihrem Lieferanten empfohlene Festplatte. Schritt 1: Die 

Schrauben lösen und die obere Abdeckung entfernen. 

Schritt 2: Ein Ende des Stromkabels der Festplatte und des Datenkabels an die 

Mutterplatine und das andere Ende an die Festplatte anschließen. 



 

Vergewissern Sie sich, dass der Videoausgang des 

Geräts und der Monitoreingang angeschlossen sind. 

Bei der Verwendung des Geräts ist das mitgelieferte 

Netzteil zu benutzen, damit die Beschädigung des 

Geräts oder eine Überlastung des Netzes vermieden 

wird. 

Achtung 

Schritt 3: Das Gerät auf die Seite legen, die Schrauben an Löcher auf der Rückseite 

des Geräts anpassen und die Schrauben festziehen. 

Schritt 4: Die obere Abdeckung aufsetzen und mit den Schrauben befestigen. 

 

 

 
 

  
 

 Vergewissern Sie sich, dass das Gerät ordnungsgemäß 

funktioniert 

Schließen Sie das Gerät an den Monitor an. Alle Geräte sind 

eingeschaltet, eine Einstellung oder automatische Paarung ist nicht 

erforderlich. Wenn das Display die grundlegenden Informationen 

anzeigt, funktioniert das Gerät normal und die Installation kann 

fortgesetzt werden. 

 



 
Übertragung der Videoaufnahme per Internet  Multi-Display-Überwachung 

 

 Antenneneinstellungen 

Die NVR-Antenne sendet Signale in die Umgebung. Um das beste Signal zu erhalten, 

platzieren Sie die Antennen des NVR und des IPC Geräts in gleicher Höhe und 

zueinander parallel. Wenn das NVR Gerät in derselben Höhe nichtaufgestellt werden 

kann, sollte die IPC-Antenne in der Richtung der NVR-Antennenmitte platziert werden 

(Abbildung 1, Abbildung 2-2). Achten Sie darauf, dass die Antenne nicht direkt auf das 

NVR Gerät gerichtet ist (Abbildung 2-1), siehe unten. 

Wi-Fi IPC 

Wi-Fi Wi-Fi NVR 

Internet HD/VGA 



Falsch Korrekt 
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Abbildung 2-1 Abbildung 2-2 

Korrekter Standort Ideale Installation 

........ .... ... .. ... 



Modify Password 

3. Betrieb des Geräts 

 Passwortänderung 
Schritt 1: Das Gerät einschalten, die Systemsprache wählen. Auf "Apply" 

(Übernehmen) klicken, das Passwort eingeben(Standardpasswort: 

„12345“), auf "Login" (Anmelden) und dann auf „Modify“ (Ändern) 

klicken, um die Schnittstelle "Passwortänderung" (modify password) 

aufzurufen.  

 

Schritt 2: Ein neues Passwort eingeben und bestätigen. Das Feld "Unlock 

Pattem" (Entsperrmuster) ankreuzen und ein ununterbrochenes, aus 4-9 

Punkten bestehendes Entsperrmuster zweimal zeichnen (muss übereinstimmen). 

Schritt 3: Eine Sicherheitsfrage einstellen. Die Sicherheitsfrage 1, 2 oder 3 

wählen, indem Sie nach unten ziehen, und die Antwort auf die entsprechende 

Sicherheitsfrage einstellen. 

Schritt 4: Den USB-Stick ins Gerät stecken und auf Schlüssel exportieren > 

Bestätigen > Speichern ((Export Key > Comfirm > Save) klicken. Das Passwort wird 

geändert. 



Quick Configuration 

BEMERKUNG 

 Schnelle Einstellung 

Nach dem Einschalten des Geräts kann der Benutzer den Assistenten verwenden, um 

Systemzeit, Netzwerkparameter, Festplattenformatierung, Kamera und andere 

Geräteparameter zu konfigurieren. 

 
Die Festplatte muss bei der ersten Installation formatiert werden. 

Die Schritte sind wie folgt: 

Wählen Sie die Festplatte in der Oberfläche "Festplatte" (Hard disk) und klicken Sie auf 

„Formatieren> Bestätigen> Bestätigen (Format>Confirm>Confirm)“, um das Gerät neu zu 

starten und die Festplatte zu formatieren. 

Bei der Erstinstallation muss die Festplatte formatiert werden.  

 

Die Schritte sind wie folgt:  

Wählen Sie die Festplatte in der Schnittstelle „Festplatte (Hard disk)“ 

aus und klicken Sie auf „Formatieren > Bestätigen > Bestätigen  
(Format> Confirm > Confirm)“, um das Gerät neu zu starten und die 

Festplatte zu formatieren 



CH1 1 

 Echtzeit-Übertragung 

Nach Abschluss der Schnellkonfiguration wechselt das System in die Echtzeit-

Vorschauschnittstelle. 
 

 

 Einstellungen der Aufnahme 

 BEMERKUNG 

Das Gerät zeichnet standardmäßig (24 Stunden) auf allen Kanälen auf. 
 

Schritt 1: In der Vorschauschnittstelle mit der rechten Maustaste auf  klicken, 

um die Aufnahme-Schnittstelle zu öffnen. 

Schritt 2: Den Kanal und die Art der Aufnahme entsprechend Ihrem tatsächlichen 

Bedarf wählen. Die linke Maustaste gedrückt halten und die Maus entlang der 

Zeitachse ziehen oder auf "Bearbeiten" (edit) klicken, um den Aufnahmezeitplan 

anzupassen, und zum Speichern auf "Übernehmen" (apply) klicken. 



 
 

 Rückwärtswiedergabe 

◊ Sofortige Wiedergabe 
Schritt 1: In der Vorschauschnittstelle auf den Vorschaukanal klicken, woraufhin ein 

Bedienfeld unterhalb des Kanals erscheint. 

Schritt 2: Auf "  "  klicken und die Schnittstelle für die sofortige Wiedergabe öffnen. Sie 

können die ersten 5 Minuten des Videos des aktuellen Kanals abspielen. 

◊ Video-Wiedergabe 

Schritt 1: In der Vorschauschnittstelle mit der rechten Maustaste auf "  " klicken, 

um die Wiedergabeschnittstelle aufzurufen. 

Schritt 2: Den "Kanal > Datum" (Channel > Date) wählen, das gesuchte Video wird in 

der Zeitleiste angezeigt, auf " " klicken, um die Wiedergabe des Videos zu starten. 

 
Recording Configuration 



Normal Event 

 
 

 Ereignis 

Schritt 1: In der Vorschauschnittstelle mit der rechten Maustaste klicken, um das 

Menü aufzurufen, und auf "  > Normales Ereignis (Normal Event)" klicken, um 

die Detektion der Bewegung (MotionDetection) aufzurufen. 

Schritt 2: Den "Ereignistyp>Kanal>Aktivieren" (EventType>Channel>Enable) wählen und die 

entsprechenden Alarmparameter einstellen. 

Zu den üblichen Ereignisalarmen des Geräts gehören Bewegungserkennung, Video-

Manipulation, Videoverlust, Alarmeingang, Alarmausgang, Ausnahme und Summer 

(Motion Detection, Video Tampering, Video Loss, AlarmInput, AlarmOutput, 

Exception, Buzzer). 
 

Playback 
14:57:20 



 Kabelloses Paaren 
Das Gerät wurde schon im Werk mit dem Code gepaart. 

Wenn eine besondere Situation eintritt, müssen Sie das Gerät erneut mit dem Code 

paaren. Klicken Sie mit der rechten Maustaste auf die Vorschauschnittstelle und 

klicken Sie auf     → „Kamera → Code des kabellosen Anschlusses 

hinzufügen (Camera →Wireless Code Add)", 

innerhalb von 120 Sekunden nach Beginn des Countdowns - drücken Sie die Taste auf 

der Rückseite der Kamera für ca. 6 Sekunden, bis das Infrarotlicht der Kamera 

aufleuchtet (blinkt). Zu diesem Zeitpunkt wird die Paarung durchgeführt. 

 



 
BEMERKUNG 

Die Taste auf der Rückseite des 

Geräts ist mit einer wasserdichten 

Abdeckung versehen. Decken Sie die 

Taste ab, wenn sie nicht benutzt wird. 

 

 

 

 

 

 

 

 

 

 Zurücksetzen 
Die Kamera unterstützt das erzwungene Zurücksetzen auf die Werkseinstellungen 

durch schnelles Drücken der Taste auf der hinteren Abdeckungslinie (3-mal), 

einschließlich der Netzwerkeinstellungsparameter und der Parameter für die drahtlose 

Paarung usw. Seien Sie vorsichtig, wenn Sie die Rückseite des Geräts anfassen. 



4. Web-Verbindung 
Schritt 1: Vergewissern Sie sich, dass sich das NVR Gerät und PC in demselben 

Netzwerk befinden. Öffnen Sie einen Webbrowser (z. B. IE) und geben Sie die 

Geräteadresse ein: z. B. "http://192.168.1.88/" (Wenn der http-Port von NVR auf 

89 geändert wird, geben Sie "http:// 192.168.1.88:89/" ein). Geben Sie Ihre 

Anmeldedaten ein. 

 

 
 

Schritt 2: Wählen Sie die Sprache, geben Sie Ihren Benutzernamen 

(standardmäßig "admin") und Ihr Passwort (standardmäßig "12345") ein und 

klicken Sie auf "Anmelden". 

Schritt 3: Klicken Sie in der Vorschauschnittstelle auf die Schaltfläche 

"Abspielen (play)", um eine Videoaufnahme anzuzeigen. Wenn Sie zum ersten 

Mal eine Verbindung herstellen, müssen Sie den Modul (plugin) herunterladen 

und installieren. 

 BEMERKUNG 

Wenn Sie über den Browser auf die Anmeldeschnittstelle des Geräts nicht zugreifen 

können, öffnen Sie den IE-Browser, wählen Sie "Tools > Internetoptionen > Sicherheit > 

Benutzer Ebene > ActiveX-Steuerelemente und Plug-ins" (Tools > Internet Options > 

Security > Custom Level > ActiveX controls and plug-ins) und aktivieren Sie alle 

Optionen. 



5. Mobile Anwendung 
Mit Ihrem Telefon den QR-Code scannen oder "BitVision" im App-

Store aussuchen. BitVision-App herunterladen und installieren. 

 
 

 
Sobald Sie registriert und angemeldet sind, können Sie Geräte zur Fernanzeige und 

Geräteverwaltung hinzufügen. 

Mehr Informationen über: 

https://www.kamerove-sety.sk/Navody- 

c32_157_2.htm 

 
Video-Anleitungen: 

https://www.kamerove-sety.sk/Video-navody- 

c32_168_2.htm 

 
Technische Unterstützung: 

0917 817 905 

http://www.kamerove-sety.sk/Navody-
http://www.kamerove-sety.sk/Video-navody-
Monitorrs
Obdĺžnik

Monitorrs
Textové pole
Mehr Informationen unter:
https://www.monitorrs.de/technischer-support

Video-Anleitungen:
https://www.monitorrs.de/videoanleitungen/

Technische Unterstützung:
+4916096272137




